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TIP! Use GpsGate to simulate a GPS during development.

Franson GpsTools .NET

Install
Install GpsTools SDK describes how to install GpsTools for .NET development.

Develop
Getting started with VB.NET
describes how to install GpsTools .NET and start writing VB.NET applications.

Getting started with C#
describes how to install GpsTools .NET and start writing C# applications.

Getting started with ASP.NET in VB
describes how to install GpsTools .NET and start writing web applications in VB.NET.

Getting started with ASP.NET in C#
describes how to install GpsTools .NET and start writing web applications in C#.

Distribute
Distribution how to distribute your GpsTools .NET application.

More usage of GpsTools:

GpsTools + GpsGate integration. - More samples The SDK conatins many
Run multiple GPS applications at the : samples, and here are some more

same time, sharing the same GPS. - samples not found in the SDK.

Access GPS from Internet Explorer

Get GPS coordinates into your HTML
page using GpsTools.

Technical support can be found in the user forum. We will constantly monitor and answer questions in the forum. The
forum also includes frequently asked question (FAQ).
General FAQ for GpsTools

Browse the Technical support forum!
Search the Technical support forum!

Install GpsTools SDK

Steps to install:
1. Download and unzip GpsTools SDK.

2. Run Set up. exe

NOTE! The Visual Basic 6.0 runtime environment must be installed for GosTool s St udi o to work. If you don't have it
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installed already it can be downloaded from Microsofts ftp-server ftp://ftp.microsoft.com/softlib/mslfiles/vbrun60sp3.exe

Index

Getting started with VB.NET and GpsTools .NET

Examples The best and easiest way to get started is to take a look at the examples.
The samples can be found in the . NET Deskt op Fr anewor k\ Sanpl es\ VB. NET directory.

Sample 1 - SerialPort

Reads data from the serial port and parses NMEA 0183 data (standard GPS protocol). Presents position as latitude,
longitude, UTM coordinates, (or other supported national coordinate system). Displays speed and satellite information.
Depends on GpsToolsNET.dll

Sample 2 - SimpleMap

Demonstrates the new raster map functionality. Connects a GPS to a map. Draws and handles graphical objects on a map,
zoom and rotation and much more. Handles mouse events. And more...

Create your own MapLibs using GpsTools Studio.

Depends on GpsToolsNET.dIl, GpsViewNET.dlI

Sample 3 - Layers
Draw objects on several of layers and how to manage layers.
Depends on GpsToolsNET.dIl, GpsViewNET.dlI

Sample 4 - MultiMap
Switch between different raster maps. Use and define blank maps.
Depends on GpsToolsNET.dIl, GpsViewNET.dlI

Sample 5 - Grid
Samples for coordinate conversion in both directions between latitude/longitude and national grids. E.g. UTM, British Grid,
Irish Grid, Swiss Grid and Swedish Grid. List of supported grids

Depends on GpsToolsNET.dlI

Sample 6 - ShapeDrawer
Draws polygons, polylines and multipoint.
Depends on GpsToolsNET.dIl, GpsViewNET.dIl, GpsShapeNET.dlI

Sample 7 - ShapeFileViewer
Load and display ESRI shapefiles.
Depends on GpsToolsNET.dIl, GpsViewNET.dll, GpsShapeNET.dll

A License key is necessary to use GpsTools. During development the key found here can be used. To distribute the
component as part of your application you need to purchase a license. The License.LicenseKey property must be set to a
valid license key by your application or else the component will refuse to work properly.

Emulator. GpsTools can be run in the Pocket PC emulator of you have a GPS to connect to the desktop PC. Read more
here about how to set up the emulators serial port.

Steps to set up project

You always need to make a reference to GpsToolsNET.dll

. To use the raster map feature you also need to make a reference to GpsViewNET.dll and add GpsViewNET.dIl to the
Toolbox to be able to draw the map control to the form during design time.

For polygon, polylines and ESRI shapefiles a reference to GpsShapeNET.dll is necessary.

1. Open a sample project.
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2. Right click on "References" and select "Add reference..."

A dialog opens:

MET | com | Projects |

Component Manme | Mersion | Path |‘~
ficcessibility  dll 1.0,5000.0 C W INDOW S Microsaft NET!,. ..
adodb 7.0,3300.0 C:\Program Files\Microsoft.M... ~
CRYsPackagelib Q,1,5000.0 C:\Program FileshCormmon Fil.
CRYsPackagelib 1.0.0.0 C:\Program FileshCommon Fil. .,
CrystalDecisions, CrystalRepa,..  9.1.5000.0 C:\Program Files\Carmmon Fil. .,
CrystalDecisions, CrystalRepa,..  9.1.3300.0 C:\Program Files\Cammon Fil. .,
CryskalDecisions. Report3ource 9,1,5000.0 C:\Program Files\Cammon Fil.,.
CryskalDecisions. Report3ource 9.1,3300.0 C:\Program Files\Cammon Fil.,.
CrystalDecisions, Shared 9,1,5000.0 Z:\Program FileshZommon Fil. ..
CrystalDecisions, Shared 9,1,3300.0 Z:\Program FileshCommon Fil. ..
CrystalDecisions, Web Q,1,5000.0 C:\Program FileshCommon Fil. .,
i rvstallerisinns . Weh 9.1.33000.0 A Proaram FilesCammnn Fil. .. ;I

selected Companents:

Cormponent Narme | Tvpe | Source

3. Click "Browse..."

4. Go up two directories.

5] 4

Zancel

Erowse, .,

Select

Hemaove |

Help
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Select Component

Loak in: I dothet
Mame = | Size | Tvpe
-4 | s File Folder
Histary IC)vE NET File Folder
Gps3hapeMET . dll 156 KE &pplication Extensi
o sToolsMET. dll 256 KE  Application Extensi
? SpsyiewhET, 252 KB Application Exkensi
My Projects L’-ﬂ MapLibMET. dll 280 KB Application Extensi
@
Deskiop
_* |
Fawvarites
sl ol

5. Select the DLLs you need to reference. Select all if you feel unsure. You can remove them later when you understand
which you do need, and which you don't need. Then click open.

6. Click "OK" in the "Add reference"” dialog".

7. Find the row which says License.LicenseKey = "...", replace that key with the one you requested from us.

8. Run your sample!

NOTE! Due to an error in VS.NET 2002 you need to set the "Copy Local" property to false for the referenced DLL:s or else
VS.NET 2002 will issue an error when trying to display the form. This bug is fixed in VS.NET 2003.

Index

A few things about the GPS. Remember that a GPS works poorly indoors. Sometimes it is possible to get a fix near a
window, but usually not. The GPS must be configured to transmitt NMEA data.

Index

Getting started with C# and GpsTools .NET
Examples The best and easiest way to get started is to take a look at the examples.
The samples can be found in the . NET Deskt op Fr anewor k\ Sanpl es\ C# directory.

Sample 1 - SerialPort

Reads data from the serial port and parses NMEA 0183 data (standard GPS protocol). Presents position as latitude,
longitude, UTM coordinates, (or other supported national coordinate system). Displays speed and satellite information.
Depends on GpsToolsNET.dII

Sample 2 - SimpleMap
Demonstrates the new raster map functionality. Connects a GPS to a map. Draws and handles graphical objects on a map,
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and much more. Handles mouse events. And more...
Create your own MapLibs using GpsTools Studio.

Depends on GpsToolsNET.dIl, GpsViewNET.dlI

Sample 3 - Layers
Draw objects on several of layers and how to manage layers.
Depends on GpsToolsNET.dIl, GpsViewNET.dlI

Sample 4 - MultiMap
Switch between different raster maps. Use and define blank maps.
Depends on GpsToolsNET.dIl, GpsViewNET.dlI

Sample 5 - ShapeDrawer
Draws polygons, polylines and multipoint.
Depends on GpsToolsNET.dIl, GpsViewNET.dll, GpsShapeNET.dlI

Sample 6 - ShapeFileViewer
Load and display ESRI shapefiles.
Depends on GpsToolsNET.dll, GpsViewNET.dll, GpsShapeNET.dl

A License key is necessary to use GpsTools. During development the key found here can be used. To distribute the
component as part of your application you need to purchase a license. The License.LicenseKey property must be set to a
valid license key by your application or else the component will refuse to work properly.

Steps to set up project

You always need to make a reference to GpsToolsNET.dIl

. To use the raster map feature you also need to make a reference to GpsViewNET.dll and add GpsViewNET.dll to the
Toolbox to be able to draw the map control to the form during design time.

For polygon, polylines and ESRI shapefiles a reference to GpsShapeNET.dll is necessary.

1. Open a sample project.
2. Right click on "References" and select "Add reference..."

A dialog opens:

http://franson.com/gpstool s/guide.asp?print=2& platform=net (5 of 22)2005-05-20 16:36:06


http://franson.com/gpstools/download.asp?&platform=net
http://franson.com/gpstools/purchase.asp?license=&platform=net
http://franson.com/gpstools/reference_manual.asp?class=License&item=LicenseKey&platform=net

GpsToolsGuidenet

MET | com | Prajects |

Component Mame I Version I Fath I*
Accessibility, dll 1.0.5000.0 CWIMDOW S Microsoft NETY. ..
adodb F.0.3300.0 C:\Program Files\Microsoft.M... =
CRYsPackagelib q,1,5000.0 C:\Program Files\Cammon Fil. .,
CRWsPackagelib 1.0.0.0 C:\Program Files\Cammon Fil.,.
CryskalDecisions. CrystalRepa,..  2.1.5000.0 C:\Program Files\Cammon Fil.,.
CryskalDecisions, CrystalRepo,..  9.1,.3300.0 Z:\Program FileshZommon Fil. ..
CryskalDecisions. Report3ource 9,1,5000.0 Z:\Program FileshCommon Fil. ..
CrystalDecisions. ReportSource 9,1,3300.0 C:\Program FileshCormmon Fil.
CrystalDecisions, Shared Q,1,5000.0 C:\Program Files\Carmmon Fil. .,
CrystalDecisions, Shared q,1,3300.0 C:\Program Files\Carmmon Fil. .,
CrystalDecisions . Web q,1,5000.0 C:\Program Files\Cammon Fil. .,
Crvstallerisinns . Weh 9.1.3300.0 N Proaram FilesCammnn Fil. .. ;I
selected Components:
Component Mame | Tvpe | Source |

3. Click "Browse..."

4. Go up two directories.

] Cancel

X

Erowse, ..

Select

Femaove |

Help
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Select Component

Loak in: I dothet
Mame = | Size | Tvpe
-4 | s File Folder
Histary IC)vE NET File Folder
3ps 156 KE &pplication Extensi
A 256 KE  Application Extensi
? 252 KB Application Exkensi
My Projects L’-ﬂ MapLibMET. dll 280 KB Application Extensi
F’ji;
Deskiop
_* |
Fawvarites
sl ol

5. Select the DLLs you need to reference. Select all if you feel unsure. You can remove them later when you understand
which you do need, and which you don't need. Then click open.

6. Click "OK" in the "Add reference"” dialog".
7. Find the row which says License.LicenseKey = "...", replace that key with the one you requested from us.

8. Run your sample!

NOTE! Due to an error in VS.NET 2002 you need to set the "Copy Local" property to false for the referenced DLL:s or else
VS.NET 2002 will issue an error when trying to display the form. This bug is fixed in VS.NET 2003.

Index

Go back to menu

Getting started with VB.NET and GpsTools .NET (for ASP.NET)

Examples The best and easiest way to get started is to take a look at the examples.
The samples files can be found in the. NET Fr anewor k\ Sanpl es\ VB. NET directory.

Sample 1 - VbSimpleMapASP

Is a web application that demonstrates some features of GpsTools abilities in Web environment. It shows how a

map interacts with mouse click and adjusts itself according mouse positions. Drawing, deleting and getting information
about Icons, Ellipses and other shapes on the map. Zoom and rotation of a map. Viewing certain part of a map that
corresponds to a fetched position from a GPS receiver. And more...

Create your own MapLibs using GpsTools Studio.

Sample 2 - VbStaticMapASP
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Is a web application that demonstrates how to view a simple static map on a web page using a GpsTools.
Create your own MapLibs using GpsTools Studio.

A License key is necessary to use GpsTools. During development the key found here can be used. To distribute
the component as part of your application you need to purchase a license. The License.LicenseKey property must
be set to a valid license key by your application or else the component will refuse to work properly.

Steps to setup project

1. Make sure you have both Visual Studio 2003 .NET and IIS installed.
2. Download and install GpsTools SDK 2.2

3. Start Visual Studio 2003 .NET and create a new web application by choosing File->New->Project.The following
dialog will then appear. Type an aplication name (WebApplicationl in this example) and press OK.

m@E Do
Project Types: Templates: 55 e
£ Wisual Basic Projects s
(] visual C# Projects H
& '-.-'isual J# Pr':'je'?ts Windows Class Library Windows
+-(_] Wisual C++ Projects Application Conkrol Library

(] setup and Deployment Projects

+-[_7] Other Projects ﬁ ﬁ
&) Ve Ve

[ Wisual Studio Solutions
Smart Device  &5P.NET Web ASP.MET Web
application Application SErvice

& project for creating an application with a Web user interface

Location: | http: fflocalhost webspplication1 j Browse, .. |

" fdd ko Solution {* Close Solution

Project will be created at htkp: fflacalbostebapplication

FhMore | K Cancel | Help |
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4. Import all files resides in the . NET Fr amewor k\ Sanpl es\ VB. NET directory into your web application by right-
clicking on the project name Add->Add Existing Item as shown in the picture below. From "Add Existing Item
dialog box" Select all files(*.*) from files of type drop down list.

#0 SerialPortCs - Microsoft Yisual C# .NET [design]
Eile Edit ew Project Build Debug  Tools  PurifyPlus  Window  H

v| p Debug

Pocket PC 2003 Emulator

4

H-ra-cd@ bRl o

Solution Explorer - SerialPortCS

= 3| E

o=

B Solution "SerialPortCS' (1 project)
B m@ R [ Build
----- E i3 Febuild
e Fi Deplay
] Buid Cab File
Add k Add Mew Tkem, ..

fdd Reference. .. Add Existing Item. ..

add Web Reference. .. New Faolder

Sef as Startlp Project Add Windows Earm, ..

Drebug * fidd Component...

& Save SerialPortCs

E Paste

« B b O EE

fdd Class, ..

Choose apply to all tems and press Yes

Destination File Exists

' & File with the name ‘BssemblyInfo,cs’ already exists, Do wou want ko
replace k7

v Apply ko all ikems

Yes Mo Cancel

If the following dialog appears, press Yes to All.
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Microsoft Development Environment

i 1Projecks\Fransonin'eblWebapplication1webFarml , aspox

This file has been modified autside of the source editor,
Do yiou wank ta reload it and lose the changes made in the source editor?

Yes Y¥es to Al Mo Mo o &ll

5. Add reference to modules GpsViewNET.dll, GpsTools.dll and System.Windows.Forms.dll . The first two
modules are located at ..\GpsTools\Net2002\Distribution\Web. Right-click on Reference and select Add
Reference as shown in the picture below.

! Solution Explorer - Webapplicationl
@ @
!E Solution "Webapplicationl' {1 project) ~
= [E} webapplication1
- @Fm
..... B | Add Reference...
""" &j add Web Reference. .. T
.... J.IIILIH'_'I e ILI_"'_'
- ----- .71 SimpleMapasP. csproj
----- wi| SimpleMapAsP.ceproj.webinfo B
Yeste|| . SimpleMapask.sin
Yeste | B @ SimpleMapAsP . sun w
2005-  [ga Solution E... | ﬁ' Class Yiew | Resource ... |
20057 | Properties o X
| El
2= 4 =]
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MET | com | Prajects |

EBrowse,..

Component fame | NErsian | Path -
Syztem, ServiceProcess, dil 1.0.5000.0 CWINDOWS Microsoft MET . Select

Syabem.Web, dll 1.0.5000.0 CWIMDOWS Microsoft MET .,
Syskem.web, Mobile,dll 1.0.5000.0 C W INDOWS Microsoft NET .
System.Web, ReqularExpressi,.. 1.0,5000.0 CWINDOWS Microsoft NET . .
Syskem.web, Jervices, dll 1.0.5000.0 CWINDOWS Microsoft NET .
Sysbem. Windows,Forms , dll 1.0.5000.0 W INDOWS Microsoft NET .
System, ¥ml.dll 1.0.5000.0 C W IMDOWS \Microsaft MET . .
WISBrowserstublib 1.0.5000.0 I WIMDOWS) Microsoft MET .
wiscar 1.0.5000.0 CWIMDOWS Microsoft MET .,
W I1sharpCodeProvider 7.0.5000.0 COWINDOWS Microsoft MET,,. =
wislib 1.0.5000.0 CWINDOWS Microsoft NET., .
wisliburia 1.M.5000.0 li':ﬁWTNhﬁW‘E\Mirrnanr.NF%. s

Selected Components:

Component Mame Twpe | Source | Femove |
Sysbem. windows.Forms. dll MNET W TMDOYW S\ Microsoft NETVFr. ..
GpsiiewMET . dl File I Projects\GpsTools\Met2002), ..
GpsToolsMET . dl File CProjecks\GpsTools\Met2002), ..
(0 4 Cancel Help

6. Right-Click on project and select property. Change Root namespace to SimpleMapASPvb.

| “Rypaton | -]

3 Common Properties Assermbly name:
g General | webapplications
Build
II'IL'II::II:Ir'tS Oukput Evpe: Startup object:
Reference Path |Cla55 Librarsy j | (Mone)

Designer Defaulks Root namespace:

Web Settings

SimpleMapasPvb
(L1 Configuration Properties | F F
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7. ImageRender.aspx (The page that does the actual drawing) has now a different namespace which has to
be changed to the web application's namespace (SimpleMapASPvDb).

1- Open ImageRender.aspx and select HTML mode. The @page directive should lookes as follow:

<%@ Page language="vb" Codebehind="ImageRender.aspx.vb" AutoEventWireup="false"
Inherits="WebApplicationl.ImageRender" %>

2- Change WebApplicationl OR the name of your web application to SimpleMapASPvb.
3- Save the file.

8. Run the application .

A few things about the GPS. Remember that a GPS works poorly indoors. Sometimes it is possible to get a fix near a
window, but usually not. The GPS must be configured to transmitt NMEA data.

Index

Getting started with C#.NET and GpsTools .NET (for ASP.NET)

Examples The best and easiest way to get started is to take a look at the examples.
The samples files can be found in the. NET Fr anewor k\ Sanpl es\ C#. NET directory.

Sample 1 - SimpleMapASP

Is a web application that demonstrates some features of GpsTools abilities in Web environment. It shows how a

map interacts with mouse click and adjusts itself according mouse positions. Drawing, deleting and getting information
about Icons, Ellipses and other shapes on the map. Zoom and rotation of a map. Viewing certain part of a map that
corresponds to a fetched position from a GPS receiver. And more...

Create your own MapLibs using GpsTools Studio.

Sample 2 - StaticMapASP
Is a web application that demonstrates how to view a simple static map on a web page using a GpsTools.
Create your own MapLibs using GpsTools Studio.

A License key is necessary to use GpsTools. During development the key found here can be used. To distribute
the component as part of your application you need to purchase a license. The License.LicenseKey property must
be set to a valid license key by your application or else the component will refuse to work properly.

Steps to setup project

1. Make sure you have both Visual Studio 2003 .NET and IIS installed.
2. Download and install GpsTools SDK 2.2
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3. Start Visual Studio 2003 .NET and create a new web application by choosing File->New->Project.The following
dialog will then appear. Type an aplication name (WebApplicationl in this example) and press OK.

MNew Project k IE|

Project Tvpes: Templates: I
{:l YWisual Basic Projects ﬂ ﬂ
5] visual C# Projects FE ﬁ
(] visual J# Projects windows  Class Library  Windows

- Wisual C++ Projects Application Conkrol Library
[ Setup and Deployment Projects

#-[_1] Other Projects r_ le% @
[ wisual Studio Solutions E-I.lﬂﬁ =, #

Smart Device ASP.MET Web ASP.MET Web
application Application SErvice

|.ﬂ. project For creating an application with a Web user inkerface

Mame: | Webapplicationl

Location: I htkp: fflocalhostwebapplication ;I Browse. ..

Project will be created at http:fflocalhostwebapplication.

FhMore | ] 4 iZancel | Help

4. Import all files resides in the . NET Fr amewor k\ Sanpl es\ C#. NET directory into your web application by right-
clicking on the project name Add->Add Existing Item as shown in the picture below. From "Add Existing Iltem
dialog box" Select all files(*.*) from files of type drop down list.
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B R N Bt SR -

SINER Al ~olution Explorer - WebApplicationl

W g &

E Solution "webapplication1' {1 project)

E| @ WebhApplicationi
[ﬁl Refe |ﬂ| Build

| >

- =1 Globe Rebuild =
Add Mew Ikem.., Add 3 |
Add Existing Tkem... Add Reference, .
Mew Faolder L‘% Add Web Reference. ..
fdd Wweb Form, .. Set as StartlUp Project

Add Web User Contral. .. Debug » i
X |

« B @ ENCEER

fdd HTML Page... E Save WebApplication 1
Add Web Service. .. [ = '
fdd Component. .. > Remove
fdd Class.,. Rename
FTUJELL TE _ _
Project Folder AR IEEES jical
= Policy
Policy File

Choose apply to all tems and press Yes

Destination File Exists

' & File with the name ‘BssemblyInfo,cs’ already exists, Do wou want ko
replace k7

v Apply ko all ikems

Yes Mo Cancel

If the following dialog appears, press Yes to All.
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Microsoft Development Environment

i 1Projecks\Fransonin'eblWebapplication1webFarml , aspox

This file has been modified autside of the source editor,
Do yiou wank ta reload it and lose the changes made in the source editor?

Yes Y¥es to Al Mo Mo o &ll

5. Add reference to modules GpsViewNET.dll, GpsTools.dll and System.Windows.Forms.dll . The first two
modules are located at ..\GpsTools\Net2002\Distribution\Web. Right-click on Reference and select Add
Reference as shown in the picture below.

! Solution Explorer - Webapplicationl
@ @
!E Solution "Webapplicationl' {1 project) ~
= [E} webapplication1
- @Fm
..... B | Add Reference...
""" &j add Web Reference. .. T
.... J.IIILIH'_'I e ILI_"'_'
- ----- .71 SimpleMapasP. csproj
----- wi| SimpleMapAsP.ceproj.webinfo B
Yeste|| . SimpleMapask.sin
Yeste | B @ SimpleMapAsP . sun w
2005-  [ga Solution E... | ﬁ' Class Yiew | Resource ... |
20057 | Properties o X
| El
2= 4 =]
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i x|

MET | com | Prajects |

Browse, .,

Component Name | Version | Fath A

Syztem, ServiceProcess, dil 1.0.5000.0 CWINDOWS Microsoft MET . Select
Syabem.Web, dll 1.0.5000.0 CWIMDOWS Microsoft MET .,

Syskem.web, Mobile,dll 1.0.5000.0 C W INDOWS Microsoft NET .

System.Web, ReqularExpressi,.. 1.0,5000.0 CWINDOWS Microsoft NET . .

Syskem.web, Jervices, dll 1.0.5000.0 CWINDOWS Microsoft NET .

Sysbem. Windows,Forms , dll 1.0.5000.0 W INDOWS Microsoft NET .

System, ¥ml.dll 1.0.5000.0 C W IMDOWS \Microsaft MET . .

WISBrowserstublib 1.0.5000.0 I WIMDOWS) Microsoft MET .

wiscar 1.0.5000.0 CWIMDOWS Microsoft MET .,

W I1sharpCodeProvider 7.0.5000.0 CWINDOWS Microsoft MET .,

wislib 1.0.5000.0 CWINDOWS Microsoft NET., .

wisliburia 1.M.5000.0 li':ﬁWTNhﬁW‘E\Mirrnanr.NF%. b

Selected Components:

Component Mame Twpe | Source | Femove |
Sysbem. windows.Forms. dll MNET W TMDOYW S\ Microsoft NETVFr. ..
GpsiiewMET . dl File I Projects\GpsTools\Met2002), ..
GpsToolsMET . dl File CProjecks\GpsTools\Met2002), ..
(0 4 Cancel Help

6. Run the application .

A few things about the GPS. Remember that a GPS works poorly indoors. Sometimes it is possible to get a fix near a
window, but usually not. The GPS must be configured to transmitt NMEA data.

Index

Developer's Guide - GpsTools Studio

NOTE! If you want a library (.NET/ActiveX) that can make MapLibs out of BMP and GIF files, take a closer look at the
MapLibXP/MapLibNET components. Start reading about the zMapLi b class.

GpsTools Studio is used to create and edit MapLibs. A MapLib contains a raster map and icons to be used in your
application.

After installing GpsTools SDK 2.0 (or later) you can find GpsTools Studio under
Start->Prograns->GpsTool s SDK->GpsTool s Studio

Create a new MapLib
You need to have a raster map in GIF or BMP format.

To create a map from a bitmap:
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HEpsTuuls Studio

File | Map Icons Help

Mew Bitmap. ..

Scaling Wizard, ..

The raster map must be conformal.(*) This means lines from south to north must be orthogonal to lines that goes from west
to east. The map can be rotated. The scale can be different (or same) in north/south direction than west/east direction.

After the bitmap is loaded a wizard will start to scale the raster map. What you need is three positions on the map with know
geographic coordinates. You also need to know which coordinate system the map is using. If you are unsure use UTM, and
use the method presented under "Verify scaling” below to see if you made the right choice.

Wizard step 1 - Select Datum or Grid.

In this step you need to specify which coordinate system your raster map is using.
I. Select a Country / Region.

Il. Select if the coordinates are specified in lat/lon or easting/northing

I1l. Select the a grid or datum.

The coordniate system choosen is that in which the map is conformal.

i _— ——
m

Icons  Help
Cong I
j:l:\'ﬁzard Step 1: Select Datum or Grid |
Wizard step 1: Select Datum or Grid
|. Country # Begion———— Il Datum ar Grid
" Laongitude / Latitud
s IInternatiDnaI j u:nng.uu i a.lu ® "
i+ Eazting / Morthing 5
drik= — . Select grd %
ikl hittp: Affransan. biz/gpstonls ILITM Morth [wgs3d] j
support@franzon. biz Ic
Zone: |34
Canicel | don't ko | Mt -
.—'—‘_'_'_'_F -
;T_# In this step yvou need Lo specify which (B [
H coordinate systemn Your raster map iz using 0
[for map projection). _I

S T
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Enter coordinates
After selecting coordinate system, click somewhere on the map and this dialog shows up:

x
Wizard step 3: Enter scaling coordinate 1 (of 3)

—|. Bitmap #. " ————— —I|. Easting # Marthing
A 141 Easting |613115 Imeters j
' (194 — Marthing |BES703Y

Cancel | Mewt -»

In this step you must enter the geographic position (==
which represtents the X, ¥ position on the raster map.

In total wvou need to specify 3 coordinates The L
coordinate should he as far apart as possible for the j

You must enter the geographic position which represents the X, Y position on the raster map. In total you need to specify 3
coordinates The coordinate should be as far apart as possible for the best results. Try to place them in opposite corners.

Verify scaling

To verify that everything is ok, click on some other known position on the map and verify that the geographic coordinate
show in the bottom line of the window is correct.

Create Icons
You can create icons (bitmaps) which you later can be drawn on the map in your application.

To create a new icon select:

! HEpsTuuls Studio
File Map | Icons  Help

Mew Icon...

Fename [Ean.,.
elete Icomn

The Icon's bitmap must be a BMP of GIF. If the GIF has a transparent color, it will be transparent in the MapLib as well. After

loading the bitmap, you need to name the Icon. This name will be used to refer the Icon in your application. See Map.
Newl con

Any number of Icons can be created. Use the menu to rename, delete and create new Icons.
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Save MapLib
After creating a Map and Icons, you need to save the MaplLib:

W Map Icons Help
Mew MapLib Zhrl-+r
iopen MapLib, .. k|40
Save MapLib Chrl+5
Save Maplib fs. .,

Exit

Now the MapLib is ready to be used by your application. See Map. Qpen.

(*)Conformality expressed in a more formal way:
When the scale of a map at any point on the map is the same in any direction, the projection is conformal. Meridians (lines of
longitude) and parallels (lines of latitude) intersect at right angles. Shape is preserved locally on conformal maps.

Here you can find some online map resources
Index

.NET Distribution

Make sure GpsTool sNET. dl | and GosVi ewNET. dl | is copied to the same directory as your application EXE file.
GpsVi ewNET. dI | is only necessary if you use the raster map feature.

Index

License |Pro + GpsGate OEM

GpsTools 2.20 (or later)
GpsGate 1.10 (or later)

Version

Share the GPS using GpsTools and GpsGate

GpsTools and GpsGate enables you to write GPS applications that can run at the same time as other applications sharing
one signle GPS. This can be very useful when for example developing an application that is a complement to a mapping or
navigation program.

You can think of GpsGate as a program that turns a GPS into a shared "multi-GPS" and you can think of GpsTools as a
toolkit for programmers who want to develop their own GPS applications in Visual Studio.

The standard way to access a GPS is by using a serial port. GpsGate provides virtual serial ports which emulates GPS
receivers. Applications connecting to those virtual ports think they have connected to a real GPS (exclusivly).

GpsTools can make use of GpsGate in a very clever way. It can detect if GpsGate is installed and use GpsGate in that case.
For detailed information on how this is done see NneaPar ser . Port Enabl ed (Method 4 - GpsGate Direct and Method 1 -

Auto detection).

GpsTools uses GpsGate API to start GpsGate and get access to GPS data, this is done without any use of virtual serial
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ports. This takes away some configuration from the end user and makes the whole solution simpler to use and more robust.

Note that GpsTools handles all calls to GpsGate API. Applications that wants to use GpsGate without GpsTools can do that
by accessing GpsGate API directly, or by using the virtual serial ports created by GpsGate.

GpsTools can be used to acces GPS data from a normal HTML page in Internet Explorer. In this case it is particular well
suited to use GpsGate, since it enables several opened browser windows to share the GPS at the same time.

The end user must also have a valid GpsGate license or your application must call Li cense. Gat eLi cense to install a
valid GpsGate Express license.

Application Application
Other GPS Other GPS
Application Application

GpsTools GpsTools
Serial port
\irtual Ports
GpzGate AP
° GpsGate
| GpsTools + Gpsate infegration
GPS () Franson Technology 2004

You can bundle your application based on GpsTools Pro with GpsGate Express for a low fixed price. Using this solution your

application can co-exist with other GPS applications and run at the same time using the same GPS. This will be experienced
as a great benefit to your users/customers.

GpsGate Express has two virtual ports which any 3rd party GPS application can connect to. And GpsGate API, which any
number of GpsTools based or other GpsGate API enabled application can connect to. In most cases this means you can
share the same GPS with two other GPS applications. For an unlimited number of virtual ports GpsGate Standard is
required.

Distribution GpsGate must be installed as a separate application on the end users computer/device. Those links can be
used for the latest version of GpsGate:

Windows:
htt p://franson. bi z/ gpsgat e/ downl oad. asp?sect i on=oen®&part ner =generi c&pl at f or n=wi nxp

Pocket PC:
htt p://franson. bi z/ gpsgat e/ downl oad. asp?sect i on=oen&part ner =generi c&pl at f or m=ppc

Go back to index

License |Standard (ActiveX)
Version |GpsTools 1.30 (or later)

Access GPS from Internet Explorer HTML page
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Using GpsTools you can access a GPS connected to your laptop or Pocket PC from Internet Explorer (or PIE). This means
you can include position information into a normal HTML form and post it up to a web server!

GpsTools SDK includes samples for Windows and Pocket PC / Windows CE.

The connection to the GPS will be exclusive which means only one browser can connect to the GPS at a time, and no other
GPS applications can use the GPS while the web page using the GPS is opened.

Internet
Explorer

GpsTools

|
GPS

For a more flexible solution you can use GpsGate in combination with GpsTools. This will allow any number of web pages,
and any number of GPS applications share the GPS at the same time. No limitations.
Read more about GpsTools + GpsGate integration here.

Internet Internet
Explorer Explorer Other GPS Other GPS
Application Application
GpsTools GpsTools
Serial port
\irtual Ports
GpsGate AP GDS Gate

| GpsTools + GpsGate infegration
GPS {¢) Franson Technology 2004

Go back to index

If you got any project based on GpsTools you want to share, please let us know and we'll publish it here. Use this form to
contact us

NAVPDA
By Robbie Robinson, robbiex@bellsouth.net

NAVPDA provides a Pocket PC display of speed, digital compass heading, compass points, elapsed distance, latitude,

longitude and coordinated universal time (UTC).
Read more...
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Download NAVPDA (VB.NET CF)

Shapefile Cutter. This sample can split an ESRI shapefile into smaller parts. If you have a huge shapefile from which you
only need a part, you can use this sample application to cut the file into smaller files, covering smaller areas.

Download Shapefile Cutter (C# .NET)
Download Shapefile Cutter (Visual Basic, 6kB)

If you got any project based on GpsTools you want to share, please let us know and we'll publish it here. Use this form to
contact us

NET

100% managed code

© 2002-2005 Franson Technology AB, All rights reserved (franson.com)
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